
ESSEX FIELD CLUB MAPMATE INTRODUCTION 
 
SOME GENERAL ISSUES ABOUT BIOLOGICAL RECORDING 
(This is a personal view as an invertebrate species specialist, County Recorder and national recording 
scheme organiser) 
 
What is the purpose of recording? 
Distribution – to enable us to map distribution at different levels of accuracy nationally and regionally. 
Ecology – to record information that will help to understand the ecology and behaviour of organisms. 
Phenology – to record information that can be used to study the phenology of species and how this might 

vary over latitude and longitude or alter with climate change. 
Conservation status – to provide information on occurrence and abundance to help inform the assessment of 

conservation status, and use this to make priorities about habitat management, development, etc. 
Change – to provide data that can be used to analyse change, e.g. in distribution and phenology, over time. 

For this we need good coverage and plenty of data – this is what MapMate can help to achieve. 
 
What is a biological record and what should we record? 
A basic biological record consists of a taxon name, date, place, grid reference, recorder and determiner. It is 
also helpful to have broad and detailed habitat information, whether adult or juvenile, sex of individuals and 
any other observations in order to enable better understanding of ecology and phenology – information not 
recorded is wasted information e.g. many invertebrates are associated more with structural features of 
habitats than NVC types and it is very useful to record this (see SRS guidance in phase 2 booklet and status 
field in MapMate). If at all possible please use accurate dates or range of dates rather than vague months or 
even years. 
 
The importance of accurate Identification and Verification 
Records based on unreliable taxon identification are worse than useless. They are a positive menace. Once 
they get into biological databases and publications they are very difficult to correct or prevent continual re-
appearance. For this reason in Essex we have County Recorders and natural history museums that centralise 
and accept records. County Recorders are especially important in making sure that recorders have the 
necessary skills to record reliably and in checking identifications, especially for species of note or outside 
their expected range. With many invertebrates, reliable identification cannot be done in the field, and 
voucher specimens are required. This should be noted in a biological record. In MapMate for example, this 
can be done in record entry by entering “!v” after the quantity in the quantity field. This automatically enters 
“Voucher retained” in the Comment field.  
 
Verification by specialists will continue to be a crucial job even when Essex achieves its own Local Record 
Centre (BRIE). It is worth mentioning here that Validation (ensuring that data have been correctly entered) 
is also an important issue – data entry by non-specialists of other people’s data all too often results in errors 
such as the entry of inaccurate and wildly impossible taxa without the non-specialist being aware of the 
significance of what they have done. It is crucial that systems are in place to enable the checking of such 
data entry by specialists. It may be easy for them to spot gross errors, but much more difficult to eliminate 
other errors. A lot of effort is put into Validation e.g. by the national BRC at Monks Wood and this will be 
needed for an Essex LRC as well. 
 
 
GETTING STARTED 
 
Loading the software 
When you load the software onto your computer you should accept the default directory (c:\program 
files\MapMate) so that MapMate updates run without problems.  
 
You should register on the MapMate website www.mapmate.co.uk/ by going to the “User Zone” and 
“Register with us”. This will enable you to receive the regular newsletters from Tecknica Ltd and the free 
software updates and patches that regularly keep checklists etc up to date. I also strongly recommend you 
become part of the MapMate User group. 
 
When you first run MapMate you will need to choose your recording preferences from the ‘Configuration 
Wizard’. You need to choose any taxonomic groups and counties or regions (e.g. Essex) that are your main 
areas of interest. This sets your configuration to those taxa and areas by the use of filters that exclude the 
other unnecessary groups. You can always change your configuration in the future. 
 
You can also change your defaults for each session by going to Data Entry – Records – Change Defaults. 
This allows you to choose from the filters included in your configuration. Note that if you have records that 



suddenly seem to disappear, or someone sends you records and you can’t find them, then look at your filter 
settings (Your Configuration) – the most likely explanation is you have not got the taxonomic groups or 
areas selected. 
 
RECORD ENTRY 
 
SPECIAL ISSUES 
Sites, Recorders and References are normally entered before entering records by going to the Record menu 
and ‘Add New’ > ‘Sites’,  ‘Add New’ > ‘Recorders’, ‘Add New’ > ‘References’ (or in Data Entry by 
clicking on e.g. ‘Site’ and ‘Add a New Site’). This only has to be done once for each Site, Recorder or 
Reference so is not as inconvenient as it might seem. 
 
Site names – these are easier to sort out beforehand than later!  
 
CONSISTENCY IS IMPORTANT 
 
e.g. I did some work for English Nature last August comparing the beetle and aculeate Hymenoptera fauna 
of one site with others in the Brecks, to clarify whether it justified SSSI status or not. This involved collating 
a very large number of records from all sorts of different sources. One of the major tasks turned out to be 
clarifying a multiplicity of site names and deciding which names referred to a single site.  
 
I suggest there is a need for an agreed standardisation of Essex site names (or the use of standardised land 
parcels for the whole county), but until that is achieved the least we should do is use names from Ordnance 
Survey maps. A standardised method of creating subsites is also important e.g.  
 
Colne Point (west) 
Colne Point (east) 
Colne Point: Area 1  
Colne Point: Area 2  
Colne Point (dune)  
Colne Point (saltmarsh) 
Colne Point (Cp A) etc 
 
can all be combined in a query by using the wildcard character “*” as in “Colne Point*”. 
 
Recorder names 
Again consistency is useful! Enter names in a standard form. I use Surname followed by initials as in 
‘Harvey, P.R.’ but a lot of other users seem to use initials then surname as in ‘P.R. Harvey’. 
 
References 
Every record has a reference, entered into the reference field. If the reference does not already exist, this 
needs to be entered separately first by ‘Add New’ > ‘References’ from the Records menu. It consists of 5 
fields: Author – the author of this reference, Year – the published year (or in case of unpublished references, 
the final year of underlying data), Page Ref – a page reference (if applicable). 
Title – short title for this reference and Comment – any comments relating to this reference. For normal 
everyday use you can use something along the lines of ‘P.R. Harvey, 2005, fieldwork’ or ‘P.R.Harvey, 2005, 
Essex Field Club - Essex Spider Group’, etc. 
 
Dates 
Most widely accepted date formats are permitted.  Whatever format you use, the date you enter is always 
resolved into dd mmm yyyy format (e.g. 01 Jan 1999).  Dates may range from 100AD to 9999AD – so there 
is no problem with either historic or foreseeable future records! 
Examples of possible input formats are: 
•  101000, 10/10/2000, 10-10-00, 10 Oct 00, 10 x 00, etc… 
The following vague date styles are also permitted: 
 
•  Year only (e.g. 1893), 
•  Month and Year (e.g. May 1960), 
 
•  Date ranges (e.g. May 1990 to June 1990, 1 Apr 1990 to 14 Apr 1990),  [Note that dates in ranges must be 
separated by the word to], and 
•  ‘today’ will enter today’s date (assuming your computer clock is correct!) 
 
 



THE RECORD ENTRY SCREEN 
 

 
 
Taxon entry 
 
This field is checked against a standard dictionary of species (called the Taxa Table) and the program will 
try to match your entry to one of these.  Irrespective of the way you enter a species name, this will be 
resolved to a standard definition.  When the field is accepted it will show the full scientific name plus the 
common name (if one exists).  The program will try to match from partial information with or without wild 
card characters and you can restrict the taxa available to your data entry by choosing a Default Taxa.  If the 
chosen taxon is a synonym then it will be shown with an = sign at the front. 
 
You can enter Scientific names, Common or vernacular names, Codes applicable to a taxonomic group (e.g. 
Bradley and Fletcher log book numbers in the Lepidoptera), but one of the easiest and standardised ways is 
to enter a 5-letter alphabetic code (without spaces) consisting of the first two letters of the generic name 
and the first three from the specific name. So, for example, Araneus diadematus (the Garden Spider) would 
be coded as ‘ardia’.  These codes are (almost) unique within a taxonomic Order and are used in many 
recording schemes to quickly identify a species. 
 
However you can also enter any number of letters including a single one that it will match to any part of a 
taxon name e.g. on my system if my defaults are spiders 'z’ gets everything with z  (as it happens all at the 
start of genus names). 'zim' gets Lepthyphantes zimmermanni, 'ele' gets Antistea elegens, Dismodicus 
elevatus, Silometopus elegans and Zelotes electus. 
 
You can enter a taxon that is not within your particular recording interests (i.e not selected in your 
configuration or current defaults) but is in the main species library by pre-fixing the name with a ~ character 
(shift+# on your keyboard).  For example, ~pieris napi, or ~winter wren would find these species even if you 
are not set up to record the Lepidoptera or Birds.  This is useful when you have a record for odd species and 
don't wish to re-configure you’re checklists or recording defaults.  Note:  If you can't find a particular taxon 
you may have a Default or ‘My configuration’ preventing it being found or the taxon may not be in the 
MapMate Taxon Library (which is generally very up to date). 



TEXT IMPORT  
One of the first things you may want to do is to import data into MapMate from other databases, 
spreadsheets etc. Text import is essentially very easy, but the process can turn out to be surprisingly fraught 
with problems due to need for data to be in absolutely precise formats. The MapMate help sets this out very 
clearly, but it is up to you to make sure your names match those in the MapMate taxon dictionary – they are 
almost always up to date. Are yours? The first time I tried a text import on my own purpose-built dBase-
compatible database I had taxon and date errors for several thousand records (out of something over 
100,000). You will be able to try out a text import later if you want. 
 
After Text Import you may choose first to put the records into ‘quarantine’ so that you can use them with all 
your other data and try them out until you are happy with them. 
 
Two sample text import files are available for you to try out later if you wish. One has two deliberate errors! 
 
 
EXPORT AND SYNCHRONISATION 
One of the most powerful features of MapMate is the ability for seamless data exchange across the internet 
to other MapMate users. The program keeps track of what records it has sent, and will only send new and 
edited records in the future. This process is called ‘Syncing’ and MapMate has a ‘Replicator’ which does all 
the work. A sync file may either be sent as an email attachment or the software can place it on the MapMate 
website and send a message to the recipient that it is there for them.  
 
 
BACKUP 
Once you have data in MapMate and maps, custom queries, normal settings, etc you do not want to lose all 
that information and effort through computer failure. There is a built-in backup facility, but this backs up 
your records and not all your maps, queries, software updates, patches and settings.  
 
By far the easiest and best way to make sure everything is backed up and easily restorable is to make regular 
copies of the whole MapMate directory and subdirectories.  
 
This can easily be done if you have a second hard drive, a CD Writer, a removable backup medium, etc.  
 
I simply drag and drop to a second (removeable) hard drive every time I have added records to MapMate, as 
well as periodically writing the whole directory to CD. This is also the way to move MapMate to a new 
computer – install MapMate on the new computer with the original installation disk and then copy your 
whole MapMate directory over the one that has been installed. 
 
 
MAPS 
Making maps from your data is one of the key features of the package. 
 
It is very easy to build simple distribution maps, and easy to add date bands although not well documented. 
There are also many much more sophicated features that can be added to maps, but this is beyond the scope 
of this introduction. If you want to do something (with maps or queries) and can’t work out how to do it,  
there will be a way – use the User Group support and someone will respond. 
 
Basic maps 
Go to File > New Map > Atlas Wizard. 
Select your taxon group e.g. ‘Araneae: Spider Recording Scheme’ 
Select your map area e.g. if you are using the sample Norfolk spider dataset choose ‘VC 27 and 28’  
Choose your base map e.g. ‘VC 27 and 28 Base Map’ 
Choose your feature title style e.g. ‘Scientific name only’ 
Choose Precision, Symbol, Size (m) and Colour e.g. ‘2km’, ‘dot’, 1600 (default) and black (default) 
Enter a name for your new atlas (or use the default). 
Click on OK, and then you will be asked to select whether to include all taxa or just those with records. 
The basic atlas is now generated. 
 
Adding Date Bands  
Click on the tick to the left of the feature list. It will darken. 
Go to Edit > Insert > Data object 
Select a date band e.g. ‘>1990’ and choose Precision, Symbol, Size (m) and Colour e.g. Black. 
Select a date band e.g. ‘<1990’ and choose Precision, Symbol, Size (m) and Colour e.g. Red. 



Now go to the feature list and find ‘All records’. This needs to be deleted so that only the two new date 
bands will show. Right-click and select delete. 
 
Now click on the feature tick to go back to normal atlas view. 
 
There is a file “MM demo atlas data banding.exe” which runs a demonstration on date banding produced by 
Ian Thirlwell for the User Group. This is provided on the disks if you want to try it out. 
 
 
SOME USEFUL TIPS 
 
Loading the software 
When you load the software onto your computer you should accept the default directory (c:\program 
files\MapMate) so that MapMate updates run without problems.  
 
If you already have an old copy of MapMate installed on your computer, but you are now installing a new 
MapMate CD with a new centre number (CUK), then you will need to do the following to delete your 
original registration first: 
 
1. Click Windows Start button 
2. Choose Run 
3. Enter: regedit 
4. Double click HKEY_CURRENT_USER 
5. Double click Software 
6. Double click VB and VBA Program Settings 
7. Click Mapmate and Edit > Delete to remove the registration 
 
Close the regedit program and then run MapMate. It will ask for your new CUK and Serial Number. If you 
have already got records in the old centre number MapMate, you will not have edit rights to the records 
since they are allocated to a different centre – you would need to import them into the new MapMate by text 
import, or ask MapMate Support if you can be given edit rights over the old CUK. 
 
 
Backup 
In terms of backup I strongly recommend regularly backing up the whole MapMate directory – this will 
make sure if you ever have a computer disaster all your data, maps, custom queries, software updates, 
patches, settings etc can be replaced without any problem by reinstalling MapMate and then copying across 
the whole directory. 
 
 
Help 
Don’t forget the built-in Help. I recommend you print off and read the Quick Start Guide before you start 
using the software for data entry. The first procedure you will need to undertake when starting to use 
MapMate is to set “Your configuration” (which can always be reset in the future). In this you choose the 
taxonomic groups and county areas that you will regularly use. These can also be changed temporarily in 
Data entry – Records – Change defaults. These are filters that show records for only those species and areas 
you currently have set – this is the first place to look if you seem to have lost a whole set of records! 
 
You should register on the MapMate website www.mapmate.co.uk/ by going to the “User Zone” and 
“Register with us”. This will enable you to receive the regular newsletters from Tecknica Ltd and the free 
software updates and patches that regularly keep checklists etc up to date.  
 
I also strongly recommend you become part of the MapMate User group. This is now by invitation only, 
due to problems with spam in the original unregistered group, and you should contact Ian Thirlwell 
ian1945@ntlworld.com to register. Not only is there ready access to rapid help from experienced users, but 
there is an file area where a range of useful stuff is available for download. 
 
 
Common settings 
If you commonly record using one set of settings you can enter these in the Data Entry screen e.g. your 
garden as the site, you as Recorder and Determiner and your Method and Reference and then save these by 
going to Records – Save Common Settings 
 
In future when you open the Data Entry screen Ctrl+G or Records – Get Common Settings will 
automatically fill in these same values for you. 



MapMate Text Import – details from the MapMate Help 
 
This topic takes you through import of tab text files.  You must have a file in the correct format first – see 
Tab Text Specification.  There are three steps to import: Capture, Resolving Content and finally the Import 
itself.  The Importer gives you the option – once you have completed an import – to keep, reject or just try 
out your data.  This ability to 'try it out' in MapMate allows you to see your data working before you commit 
the import. 
 
To Import your file: 
Open MapMate 
Choose File > Import > 'Data from Tab Text Files' 
Step 1 – Capturing your file 
MapMate captures your tab text file by reading it into a temporary database.  During this stage it will be 
checked for errors and any violations against the specification. 
1.  Select your file by clicking on the […] button to the right of the file name box 
2.  Click on the 'Test File' button 
Your file will be tested.  If your file has a 'serious' error – 
 like the file format is incorrect – then you can't proceed.  If there are 'minor' errors the 'View Errors' button 
will be enabled – click on this to review them.  Each row in error is indicated (this is the record position in 
your file) with an error message.  If you have errors you should try to resolve them before importing.  Copy 
and keep the error report – resolve the errors and then re-create your file. 
 
•  If you wish, you can proceed with errors and capture all of your file less the rows in error and add these in 
later manually – to do this make sure you leave the 'Reject Records in Error' option ticked. 
•  If you have no errors, or wish to proceed anyway, then continue… 
3.  Click on the Read File button. 
Your file will be read into a temporary database.  When complete you can click on the 'Browse' button to see 
your captured data.  If you have any records with errors they will be included in this browse so you can 
check them out.  When you are happy continue to Step 2… 
 
Step 2 – Resolving file content 
MapMate needs to create new entries for each unique Site, Recorder and Method you have used - plus it 
needs to know that every taxonomic name used has a corresponding entry in the Taxa Library.  Note: The 
program will not add in new Taxa – any records with unresolved species will not be imported.  This step 
gives you the opportunity to check that all of these definitions are OK. 
1.  Choose each of the options in turn – Taxa, Sites, Recorders (which include Determiners), Methods, Sex, 
Stage and Status – for each > 
 
2.  Click on the 'Check' button 
•  If the program reports 'All the … are already in your database' then you have nothing to resolve. 
•  If the program produces a list – then these are new entries that will be created on import (except Taxa, 
Sex, Stage and Status which are fixed).  You have the opportunity now to manually 'Add' these entries or 
just continue.  Adding manually gives you the advantage of more control over data entry and permits you to 
include other information now – like recorder locations or site habitats. 
 
•  If you see that you have made mistakes or could rationalise some definitions then you will have to go 
back, edit your original file and start again.  You can continue and edit things later from MapMate if you 
wish.  You need to ask yourself: would it be easier to correct this in my original data or later in MapMate? 
•  Click on the 'List Used' button to see exactly what entries you have used for each selected option. 
•  Click on the 'Any dups?' button to see if any Taxa, Sites, Recorders or Methods have duplicate entries in 
your existing MapMate dataset.  Duplicates are where say you have more than one Site with identical Name, 
Gridref and VC.  MapMate will choose the 'first' one it finds and use this for import, as it cannot resolve this 
further.  This may, or may not, be an issue. 
 
When you are happy continue to Step 3… 
Step 3 – Import 
1.  To import, simply click on the Import button. 
You can't stop the importer once it's started.  [If your PC fails or some other disaster strikes while the 
importer is running, then MapMate will recover – when you next run the program, open the Importer and 
choose 'no' to keep your data].  Import is 'fairly' fast – about 1000 records a minute on a typical PC – so if 
you have thousands go put the kettle on! 
 
•  The importer will create definitions for all new Sites, Recorders (plus Determiners) and Methods. 
•  The importer will create a new Reference for all your data – this is automatically entered with the Author 
as 'Centre <your CUK>' and a Tile constructed from your file name.  You can edit this to reflect your import 
content once you have accepted the import.  [Tip: To edit this Reference: Browse > 'Browse Tables' > 
'Browse References', find your reference and then 'Edit'] 
 
2.  When complete click on 'Done'. 
•  You will be asked if you wish to keep, remove or 'try out' your data. 
All records and other definitions all held in a temporary layer of your dataset until you decide to keep or 
reject them. Generally choose 'Cancel' = try out.  You can then use your data with all of MapMate's 



functionality to see that it works.  To accept or reject the data simply open the Importer again.  If you choose 
'No' then all of the import (including associated Sites, Recorders etc) will be removed.  [Tip: The 'temporary 
layer' of your dataset is generation=0.  You can use the 'Database Info' queries to explore this layer further.] 
 
Tab Text Specification  - Text Import Field Names 
•  The following are the required fields and their names in order (as they would appear left to right): 
Taxon – the full scientific name of the species recorded e.g. Pieris napi.  The Taxon is always required and 
must exactly match an existing entry in the MapMate Taxa Library. 
Site – the name of the recorded site e.g. Stoke Sub Hamdon.  The Site is always required. 
Gridref – the OS Grid-reference of the Site e.g. ST123456 (use can use 10km, 2km, 1km or 6 to 8 figure 
references as you wish).  Avoid spaces.  If your reference contains dashes for unknown entities (like ST12-
45-) then these are resolved to the correct 'short' format.  The Gridref is always required. 
 
VC – the Vice County number for the Site (1..113 or H1..H40 for Ireland).  The VC is always required.  If 
you can't resolve a Site to a VC use 0. 
Recorder – the name of the recorder e.g. Mark Yeates.  The Recorder is always required. 
Determiner – the name of the determiner e.g. Mark Yeates (if this field is left blank then the Recorder will 
be assumed Determiner).  The Determiner is the person (or authority) who formally identified the species (if 
applicable). 
 
Date – the date on which the Taxon was recorded – this must be in dd/mm/yyyy format e.g. 12/07/1998. 
Two digit years are not allowed!  If the Date is a month only you can use 00/mm/yyyy.  If the Date is a year 
only you can use 00/00/yyyy.  If your date is a year range use yyyy->yyyy (i.e. with a dash followed by a 
greater than sign between).  If your date is a date range use dd/mm/yyyy-dd/mm/yyyy (i.e. two dates with a 
dash between).  A Date is always required. 
 
Quantity – the number of individuals recorded e.g. 2.  Quantity must be a number or 0, which is equivalent 
to 'Present'.  If the quantity is left blank then 0=Present will be assumed. 
Method – is the recording method used e.g. Netted, Field Record etc.  Methods should be consistent with, or 
use, existing MapMate methods.  If the method is left blank then the default 'Unknown' will be used.  If a 
Method is unknown – then a new method will be created for you. 
 
Sex – is the sex of the recorded taxon.  If this is left blank then the default 'not recorded' is assumed.  You 
can use the following single letter codes:  Male=m, Female=f, Queen=q, Worker=w, Asexual=a, Mixed sex 
group=g, Intersex=i, Pair=p, Not recorded=u. 
Stage – is the life stage of the recorded taxon.  This must be one of the pre-defined values in the MapMate 
TaxonStage table.  Browse Taxon Stage to see possible values.  If this field is left blank then 'not recorded' is 
assumed. 
 
Status – is the record status for this particular taxon in context of this record. This must be one of the pre-
defined values in the MapMate RecordStatus table.  Browse Record Status to see possible values.  If this 
field is left blank then 'not recorded' is assumed. 
Comment – is for any additional information, or any comments about this record.  Comment is not required 
and may be left blank.  Comments can be any length. 
Notes 
•  When you import, any new Sites, Recorders, Determiners and Methods you have identified will be created 
for you. 
 
•  All fields are 'text' fields and you can use any alphabetic or numeric characters. 
 •  Taxa, Site, Recorder, Determiner, Method, Stage and Status fields are all limited to 64 characters 
maximum. Gridref and Quantity are limited to 10 character maximum.  VC is limited to 3 characters 
maximum.  Sex must be a single character code and Comment can be any length.  Dates are restricted by 
required formats and not size. 
•  When exporting tab-text from spreadsheets like Excel, we suggest that ALL 'not required' fields are 
present and filled with "" (i.e. two double quotes with nothing between) – or with a literal default value 
applicable to the field, like 'not recorded' etc.  This is to make sure they are exported correctly! 
 
•  Note that a Quantity of 0 (zero) is interpreted by MapMate as 'present, quantity unknown' and NOT as 'not 
recorded'. 
•  Import will reject records with Taxa that it can't find in the Taxa Library – it will not create new entries 
from these.  The Importer has tools built in to check these for you (see note below). 
•  When importing from other recording programs (like R3.3., R2000, etc.) make sure you run the 'Check' 
button test on Taxa prior to import and correct any species names in your original import file.  MapMate has 
very up to date checklists and there may be some differences with naming here!  If you find any names that 
are in error on MapMate please let us know at support@mapmate.co.uk.  If you do find a name in error then 
you can miss-spell it for now (to import) and when it is globally corrected your record will be corrected too! 
 
•  You can use the Analysis > Browse > 'Browse Tables' queries to see currently available terms for Sex, 
Stage, Status, Methods etc. 
•  Take care with dates – formatting requirements are quite strict here! 


